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Partnerships (1065)

The basics of data entry for a partnership (1065) return are the same as for the 1040. 
Navigation through data entry, field- and screen-level help, and keyboard shortcuts all 
function as they do in the 1040 program. See the Drake Software User’s Manual: Tax 
Year 2015 for the basics of using the program. (The manual is available on the instal-
lation CD and on the Drake Support website: Support.DrakeSoftware.com > Training 
Tools > Manuals.)

What’s New in Drake for Partnership Returns

Drake programs its tax software according to the latest IRS rules and regulations. The 
2015 program reflects all changes to credits and deductions, including discontinua-
tions. For details on new regulations for 2015, see the IRS instructions for Form 1065.

Schedule M-1 Adjustments to Section L of Schedule K-1

Schedule M-1 adjustments entered in the “Other” fields of screen M1 on lines 2, 4, 6, 
and 7 will now adjust Section L, “Partner's capital account analysis,” of Schedule K-1. 
A new Other screen (with links on screen M1) and new SA screens have been added 
that allows the amounts to be specially allocated among partners.

For more on the “Other” fields of screen M1, see “New “Other” Adjustments” on 
page 35. For more on using the Special Allocation (SA) screens, see “Special Alloca-
tions” on page 21.

Screens K, KFT, and Special Allocations

To promote greater accuracy in allocating Schedule K data to the individual partner’s 
Schedule K-1, and to improve the detailed statements provided to partners on their 
K-1s, Drake has made several enhancements to the Partnership package.

Among the biggest changes is streamlining and consolidating data entry for Schedule 
K line items with a redesigned screen K. We have also added a new KFT screen for 
reporting foreign transactions and a “Foreign Transaction Statement” that lists all of 
Tax Year 2015 1
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the partnership’s foreign transactions. A new Special Allocation screen provides an 
easy way to allocate any of the items on screen K for any or all of the listed partners.

For details, see “Schedule K (Partners’ Distributive Share Items)” on page 20 and 
“Multiple Foreign Transactions” on page 23.

EF “ACK” Page

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal and state 
business packages now generate an “EF_ACK” page for the main forms of federal 
returns and “(ST)EF_ACK” page for the main forms of state returns.

This is a Drake-generated form that serves the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake and received by the 
IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF_ACK is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return), and a check box indicating the return was received by the IRS 
or applicable state agency.

When the return has been accepted—when you download and process your acknowl-
edgments and receive an “A” ack—the second section of the EF_ACK is generated, 
indicating the return was accepted by the IRS or state agency and the date the return 
was accepted. The submission ID number is also included.

Additions to ES Screen

Two changes were made to the Estimated Taxes (ES) screen for 2015:

• If you are not filing four quarterly state vouchers—for instance, if filing too late to 
make the first quarter payment—the program now adds the amount of the missed 
payment to the next available voucher. Enter “0” in the Estimate amt voucher 
field for quarter the payment was not be made.

• An Increase/Decrease calculated estimates by... text box was added that allows 
you to adjust the total estimated taxes due.

For details on using the ES screen for filing and paying state estimated taxes, see 
“Estimated Taxes,” in Chapter 5 of the Drake Software User’s Manual: Tax Year 2015.

Form 4562

Drake now produces one Form 4562 for each property on Schedule E and Form 8825 
instead of one 4562 per Schedule E or 8825.

Form 8878-A

For electronic payments on extensions, the program produces Form 8878-A, the IRS e-file 
Signature Authorization for Form 7004.
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1099 Screens

We added a state-only screen 99M (1099-MISC) for miscellaneous income and screen 
W2G, Gambling Income, to the States tab of the Data Entry Menu.

Short-Year Return Screen

Enter short-year return election information and 52-53-week elections on the new 
Year screen. See “Short-Year Returns” on page 4 for more information.

Expanded Partner Information

Drake has added a Suffix drop list and Professional text box to the partner informa-
tion sections of the PIN screen. These new fields allow you to enter such designations 
as “Jr.”, “Sr.”, “III” to the name of the partner or corporation officer, and such profes-
sional designations as “Dr.” or “Ret.”

Royalties Worksheet

A new worksheet for reporting royalty expenses and income was added to the Partner-
ship package.

See “Royalties Worksheet” on page 41.

Foreign Tax Withheld

Screen Code: 
8813

The new screen 8813, Partnership Withholding Payment Vouchers, allows you to 
enter amounts paid by the partnership in the prior year on foreign tax withheld and to 
produce vouchers for making 2016 quarterly payments. The filing and mailing 
instructions are listed on screen 8813.

Screen 8813 is accessible from the Other Forms tab of the Data Entry Menu.

Practice Management Tools

For details on additions and enhancements to Drake’s practice management tools—
such as the e-mail program, the letters and billing editor, and the Scheduler—see the 
Drake Software User’s Manual: Tax Year 2015. 

Updating a Prior-Year Return in Drake

If you prepared the tax return in Drake last year, you will need to update the return for 
the current year. A prior-year return can be updated in three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2014 to 2015 (recommended) 

• When you open the return for the first time in the 2015 program and are prompted 
to update it

• With all other returns in the program using Last Year Data > Update Clients 
2014 to 2015 (not recommended)
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When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.

Name and Address

Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. (Access screen 
2 from the States tab of the Data Entry Menu, or enter 2 in the selector field and 
press ENTER.) 

Tax Year

The software uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for a December 31 tax year-end.

Fiscal and 
Calendar 

Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not a calendar 
year section of screen 1.

52-53-Week 
Tax Year

For information on electing a 52-53-week tax year, see “Electing a 52-53–Week Year 
(Initial Return)” on page 46.

Short-Year 
Returns

A partnership may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

Screen Code: 
YEAR

New for 2015: In the past, short-year return election information and certain other 
elections made by business entities were entered in Drake on the ELEC screen. Start-
ing this year, short-year return election information and 52-53-week tax year informa-
tion is entered on the Year screen, available on the Miscellaneous tab of the Data 
Entry Menu or from a Year link on screen 1.

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year beginning and Fiscal year 
ending fields, even if the firm uses the calendar year for full-year returns. (These 
dates will appear on the top of the federal form.)

2. Click the Year link (Figure 1) to open the Year screen.

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 46.
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Figure 1: Click the Year link to open the new Year screen.

3. On the Year screen, make your short-year selection from the Other short-year 
reason drop list. Your explanation will be displayed at the top of the first page of 
the tax return. If you do not select an explanation, an EF Message will be gener-
ated with the return, and the return cannot be e-filed.

4. If you selected “General Explanation” from the Other short-year reason drop 
list, type details on the reasons for filing a short-year return in the new Explana-
tion text box.

For information on making elections through the ELEC screen, see “Elections” on 
page 42.

Boxes A through J

Enter most information for boxes A through J (top of Form 1065) on screen 1. Note 
that boxes D (Employer identification number), F (Total assets), and J (Schedule C 
and M-3 attached) are completed automatically based on information entered else-
where in the program. Other boxes are:

• Box A — Principal business activity

• Box B — Principal product or service

• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)

• Box E — Date business started

• Item G — Initial, final, or amended return; address or name change; technical ter-
mination

• Item H — Accounting method (Select Cash, Accrual, or Other; if Other, enter a 
description of the method used.)

• Item I — Number of K-1 forms attached (Completed automatically based on the 
number of K1 screens filled out. Use screen 1 to override this number.)

NOTES
For more information on short-year returns, see IRS Pub 4163.

The program may not correctly calculate depreciation, gains, or 
losses for a short-year return. Depreciation for a short-year return 
can be manually entered on screen 4562 or screens 6, 7, 8, and 9.

NOTE
A technical termination occurs when there has been a sale or exchange 
of 50% or more of the interests in partnership capital and profits within a 
12-month period. On screen 1 in Drake, mark the Technical termina-
tion box and either Initial Return or Final Return as applicable.
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Income and Deductions

Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other 
Income (Loss)” on page 7.) DED screen amounts flow to Form 1065, page 1, lines 9 
through 20. “Other income” and “Other deductions” data is shown on attached state-
ment worksheets in View mode of the return.

Gross Receipts

Enter gross receipts or sales and returns and allowances on the INC screen.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3, “Inventories.” Note that the inventory fields on screen L (Schedule L - 
Balance Sheet - Assets) are overrides; entries there override inventory data from 
screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake, two fields on screen A are provided for line 5: one for other costs 
including depreciation and one for other costs excluding depreciation. (Figure 2).

Figure 2: Other costs and depreciation

In the Other costs - depreciation field, enter any depreciation that relates to the cost 
of goods sold (unless the amount is flowing from the 4562 Detail screen with COGS 
selected from the For drop list). Note that this field on screen A is an override field; an 
entry here overrides the calculations from the 4562 screen. Amounts entered in this 
field automatically adjust the total depreciation that is carried to page 1 of Form 1065. 
For Other costs - excluding depreciation, use a detail worksheet (CTRL+W). The 

NOTE
The IRS does not require a detail worksheet (CTRL+W) for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any other line that 
does not require a detail worksheet.

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing 
these fields, press F1 or consult the IRS instructions.
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depreciation amount is included on the statement for other costs and should not be 
included in the Other Costs worksheet.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 51), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry. When the trial balance is imported, the COGS 
depreciation expense amount flows directly to the appropriate line of Form 1125-A 
and is calculated accordingly. For more on depreciation and trial balance import, see 
“Depreciation” on page 58.

Ordinary Income (Loss)

Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

Net Farm Profit (Loss)

Screen Code: F The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 
entered on screen F (Farm Income and Expense). Farm profit or loss from other 
partnerships, estates, or trusts appears on line 4 of the return. To enter this informa-
tion, from the INC screen, click the links to screen K1P or screen K1F on line 4. 
Enter the farm profit or loss from other partnerships, estates, or trusts on line 1 of 
screen K1P or line 6 of screen K1F.

For information on farming partnerships with a corporate partner, see Pub. 225, 
Farmer’s Tax Guide.

Net Gain (Loss)

The amount on line 6 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1065 flows from Form 4797. Amounts can also flow from screen 4562, but only if that 
screen shows assets sold and property type.)

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View mode of the 
return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Biofuel Producer Credit

• Screen 8864 — Form 8864, Biodiesel Fuels and Low Sulfur Diesel Fuel Produc-
tion Credits

Additional fields on the INC screen include:

NOTE Line 16b on the DED screen is an adjustment field for depreciation 
from Form 4562 not entered on screen A.
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• Interest income on receivables

• Recoveries of bad debts deducted in earlier years

• Section 481 adjustments

• State tax refund (cash basis)

• Taxable income from insurance proceeds

• Other income (itemize)

Enter additional sources of income not shown in the Other income (itemize) field. 
Begin typing in that field and a detail worksheet (CTRL+W) is opened with fields for 
descriptions and amounts.

To enter other income (loss) from a partnership, estate, or trust, use the K1P or K1F 
screen (click the links on line 4 of the INC screen).

Compensation and Wages

Use line 9 of the DED screen to enter wages and salaries paid. Do not include guaran-
teed payments to partners or salaries or wages reported elsewhere in the return, such 
as the amounts included in COGS, elective contributions to a section 401(k) cash or 
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake automatically adjusts salary and wages for employment credits.)

Guaranteed Payments and Partner Health Insurance

Use the DED and K screens to report guaranteed payments and partner health insur-
ance. Note that guaranteed payments and health insurance are entered as separate 
amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on the DED screen, line 10.

• An entry on screen K (Income/Loss tab) adjusts the amounts (adds to or subtracts 
from) an amount entered on the DED screen.

• New for 2015: To allocate the total guaranteed payments among the partners, click 
the SA link to the right of the amount field on line 4a of screen K (Income/Loss) 
tab. (For details on using the SA screen, see “Special Allocations” on page 21.)

Guaranteed payments should include any payments (or credits) to a partner for ser-
vices rendered. Include the use of any capital the partner provided if the payments (or 
credits) for that capital are not determined by the partnership’s income and can be 
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allocated to a trade or business activity. These entries should not include any payments 
and credits that should be capitalized or any distributive shares of partnership profits.

Partner 
Health 

Insurance

To report partner health insurance:

• Enter the total deductible in the Partner’s health insurance field on the DED 
screen, line 10.

• An entry on line 13d, item “M,” of screen K (Deductions tab), adjusts the amount 
(adds to or subtracts from) entered on the DED screen.

• New for 2015: To allocate the total amount of health insurance costs among the 
partners, click the SA link to the right of the amount field on line M of screen K 
(Deductions tab). (For details on using the SA screen, see “Special Allocations” 
on page 21.)

These amounts should include premiums for health insurance paid by a partnership on 
behalf of a partner, for services as a partner or a partner’s spouse or dependents.

Entries flow to boxes 4 and 13 of the partners’ Schedule K-1, and to the total on line 
13d of Schedule K.

For information on the partnership’s contribution to a partner’s Health Savings 
Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.

Repairs and Maintenance

Use the DED screen to enter the costs of repairs and maintenance. See Form 1065 
instructions for IRS requirements regarding costs that can be entered here.

Bad Debts

Use the DED screen to enter the total of all bad debts that became worthless during 
the 2015 tax year, but only if these debts related to a trade or business activity. Deduct-
ible non-business bad debts should be entered as short-term capital losses on screen 
8949.

NOTES

Guaranteed payment amounts are carried to the partner's Schedule 
K-1, based on percentages entered on screen K1. Amounts allocated 
to the partners can be overridden on screen SA.

Access screen K from the General tab of the Data Entry Menu, enter 
K in the selector field and press ENTER, or click the Sch K Income 
link at the bottom of any partner’s K1 screen. Click SA on line 4a to 
open the Special Allocations screen.

NOTE Cash-method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.
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Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the partnership rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the partnership, and then 
complete Part V of the 4562 (screens 8 and 9).

Taxes and Licenses

Use the DED screen to enter tax and license payment data. Amounts entered here flow 
to the “Taxes and licenses” line of Form 1065. Data is also generated on the ATT_PTL 
worksheet in View mode of the return.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 
amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used, and which tax type is selected.

Interest 

The “Interest” line of Form 1065 refers only to the interest incurred by the partnership 
in a trade or business activity that is not claimed elsewhere in the return.

Use the DED screen to enter interest expense amounts. Do not include interest 
expense on the following:

• Debt required to be allocated to the production of qualified property

• Debt used to buy rental property or debt used in a rental activity

• Debt used to purchase property held for investment

• Debt proceeds allocated to distributions made to partners during the tax year

Self-Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be attached to the return. To attach the 
statement:

Screen Code: 
SCH

1. Open the SCH screen (available from the Miscellaneous tab of the Data Entry 
Menu).

2. In the Statement number field, type 03 (select 006 - General EF Statement.)

3. Assign a title such as “Self-Charged Interest” (no quotation marks needed).

4. Enter the following data, each on a separate line:

• Partnership name

• Street address (U.S. only)

• City (U.S. only)

• Two-letter state code (U.S. only)

NOTE
Credit from Form 8846, Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips, automatically adjusts the 
amount of taxes and licenses on Form 1065.
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• ZIP code (U.S. only)

• EIN

• “REGULATION SECTION 1.469-7(G) DECLARATION” (no quotation 
marks needed)

Do not mark the In-house note check box at the bottom of the SCH screen.

For more information on self-charged interest rules, see the “Self-Charged Interest” 
section of the Form 1065 instructions.

Depreciation

Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (rental other than real estate), and Section 754. (To 
associate a depreciable asset with an activity, make a selection from the For drop list 
at the top of the 4562 screen.)

Using the 
DED screen 

for Direct 
Entry

As explained further in the “Line 16, Depreciation” section following, the DED 
screen has two lines for direct entry of depreciation:

• Line 16a — Depreciation

• Line 16b — Depreciation claimed elsewhere on return

Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

For more information on depreciation and the 4562 screen in Drake, see the Drake 
Software User’s Manual: Tax Year 2015.

Line 16, 
Depreciation

Line 16c of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) 
is not claimed elsewhere. While the program pulls data from the 4562 screen for this 
line, it also provides field 16b (Figure 3) specifically for depreciation that is claimed 
elsewhere.

Figure 3: Depreciation line 16 fields from DED screen

NOTE Using the SCH screen for this statement will not prevent the return 
from being e-filed.

IMPORTANT The depreciation fields on any screen should be used 
only if Form 4562 is not required.
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Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract 
from program calculations that are based on entries elsewhere in the program. Enter 
only the depreciation claimed on assets used in a trade or business activity:

• Line 16a — An entry here is added to the depreciation from the 4562 screens. The 
amount on line 16a is not reflected on Form 4562. See field-level help for further 
instructions and information on how this field ties in to the 4562.

• Line 16b — Drake recommends using screen A (rather than the DED screen) to 
enter depreciation claimed on Form 1125-A. An entry on screen A adjusts any 
entry on line 16b of the DED screen and is calculated into the total deductions on 
Form 1065. If there is an entry on line 16b but not screen A, only the line 16b 
amount is calculated into total deductions.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select 754 from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Spe-
cial Allocations” on page 21 and “Section 754 Allocations” on page 29.

Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each 
partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.

2. From the Method drop list, select AMT - Amortization.

3. Complete the applicable fields in the Amortization Information section, located 
near the bottom-left corner of screen 4562.

Depletion

Enter depletion amounts on the DED screen. If the corporation claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as 
PDF to e-filed returns. See “The PDF Attachment Process” on page 48.) Do not 
deduct depletion for oil and gas properties.Depletion should be figured for each part-
ner. 

Retirement Plans

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS 
instructions for guidance on what costs are acceptable for this line.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (“Salaries and wages” line) or screen A 
(“Cost of labor” line).

NOTE
The program reduces the expense based on the credit amount calcu-
lated from Form 8881, Credit for Small Employer Pension Plan 
Startup Costs.
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Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners to retirement or 
deferred compensation plans, IRAs, qualified plans, Simplified Employee Pension 
(SEP), or SIMPLE IRA plans. Report these amounts, which are deducted by the part-
ners on their own returns, on screen K (Deductions tab), item 13d, code R. 

Employee Benefit Plans

Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, “Retirement plans, etc.”

Amounts 
Paid for 

Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 8.

Pub. 541 IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf 
of a partner for services as a partner, are treated as guaranteed payments. The partner-
ship can deduct these payments as a business expense, and the partner must include 
them in gross income. The partnership cannot deduct the premiums, however, if the 
partnership accounts for insurance paid as a reduction in distributions for that partner. 
In that case, go to the K1 screen for the partner and mark the Health Insurance dis-
tribution reduction box at the bottom of the screen.

A qualifying partner can deduct 100% of the health insurance as an adjustment to 
income. The partner cannot deduct the premiums for any calendar month, or part of a 
month, in which he or she is eligible to participate in any subsidized health plan main-
tained by the employer of the partner or the partner’s spouse.

Other Deductions

Enter all other deductions on the DED screen. Drake calculates these amounts and 
incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization

• Credit adjustment from Form 6765, Credit for Increasing Research Activities

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Filing an Extension

Calendar year returns are due on April 18, 2016. By filing Form 7004, a partnership 
can extend the deadline five months to September 15, 2016. Fiscal-year returns are 
due on the fifteenth day of the fourth month after the end of the fiscal year.
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To file a 1065 extension, use one of the following options:

• Go to the 7004 screen in Drake (Other Forms tab of the Data Entry Menu) and 
select Generate an extension. Complete any other applicable fields on the screen.

• Go to the PRNT screen and select Prepare a Form 7004 extension.

Signing the Return

PIN signatures are required for e-filed returns. To e-file a return, complete all fields on 
the PIN screen. A return cannot be e-filed if the PIN screen is not completed, includ-
ing title and signature (name) of the general partner or LLC member manager.

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided on the PIN screen. If it is pre-
pared by a partner or an employee of the partnership, select NONE in the Firm # and 
Preparer # drop lists on screen 1.

To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
PIN entered should match the one entered for the preparer in Setup > Pre-
parer(s). (For more information, press F1 in this field.)

New for 2015: The optional Suffix drop list and Professional text box were added to 
the PIN screen to allow you to enter such designations as “Jr.”, “Sr.”, “III” to the name 
of the partner or corporation officer, and such professional designations as “Dr.” or 
“Ret.”

Missing PIN 
Information

If you receive an EF Message stating, “Missing Information on the PIN screen,” check 
the Title and Signature (name) fields the PIN screen for the partner signing the 
return. All applicable fields must be completed. (Phone number and e-mail address are 
not required.)

Form 
8879-PE

You must receive the completed and signed Form 8879-PE, IRS e-file Signature Autho-
rization for Form 1065, before the return is e-filed. This form must be kept in the tax 
office for three years from the return due date or IRS received date, whichever is later.

For information on using an electronic signature pad to digitally sign Form 8879-PE, see 
“Electronic Signatures” in Chapter 6, “Return Results,” of the Drake Software User’s 
Manual: Tax Year 2015.

NOTE
Setup > ERO must still be completed in Drake for e-file. For information 
on how to complete this setup window, see Drake Software User’s 
Manual: Tax Year 2015. See the IRS instructions for further details on 
signature requirements.
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Amending a Return

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry and select Amended return in section G.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and select Amended 1065 in the left-hand column.

4. Go to the SCH screen and complete the following fields:

• Statement number — Type 011 - Amended Return Statement.

• Title — Enter a statement title of 28 or fewer characters.

• Explanation text box — Identify the amended items by line number and 
explain what was changed and why. 

If amending just the K-1s, go to each K1 screen, select Amended K1, and make 
needed changes.

TEFRA and Filing Eligibility

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the tax matters part-
ner (TMP) must file a Form 8082 on the partnership’s behalf and request the IRS treat 
the Form 8082 as a substituted return. A partnership qualifying as a small partnership 
(see Section 6231(a)(1)(B)) – with 10 or fewer partners at any one time during the 
year – is exempt from the TEFRA audit rules and can file an amended Form 1065 and 
corrected K-1s to partners.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B

The program has three screens for entering data for Schedule B, Other Information:

• Screen B — For all but lines 3 and 4

CAUTION
When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, 
you should archive the original to avoid losing previously sub-
mitted data. For more information on archiving returns, see 
“Archive Manager” in Chapter 6, “Return Results,” of the Drake 
Software User’s Manual: Tax Year 2015.

NOTE
When amending a 1065 return, all K-1s are amended, and the 
“Amended K-1” box on the return is marked automatically To override 
this default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1.
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• Screen B1 — For lines 3a and 3b

• Screen B4 — For lines 4a and 4b

From screen B, you can access screens B1 and B4 by clicking the applicable hyper-
links or by pressing PAGE DOWN (once for screen B1; twice for screen B4).

Ownership If any partner (foreign or domestic corporation, partnership, or trust) owns, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital of the partnership, go to 
screen B1, the Line 3a section, and make a selection from the EIN and Name of 
Entity. Complete the line by selecting a type of entity, country of organization, and 
maximum percentage owned in profit, loss, or capital.

If a partner (individual or estate) owns, directly or indirectly, an interest of 50% or 
more in profit, loss, or capital of the partnership, go to screen B1 to the Line 3b sec-
tion and make a selection from the ID and Name of Individual or Estate drop list. 
Complete the line by marking the Select if an estate check box (if appropriate), then 
choose a country of citizenship and enter the individual or estate’s maximum percent-
age owned in profit, loss, or capital.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, 50% or more of the total voting power of all classes of stock entitled to vote 
of any foreign or domestic corporation, use the Line 4a section of screen B4 to enter 
the corporation’s name, EIN, country of incorporation, and percentage owned in vot-
ing stock.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or 
domestic partnership or in the beneficial interest of a trust, use the Line 4b section of 
screen B4 to enter the entity’s name, EIN, type, country of organization, and maxi-
mum percentage owned in profit, loss, or capital.

Line 6 
Require-

ments

If question 6 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

1. The partnership’s total receipts for the tax year were less than $250,000.

2. The partnership’s total assets at the end of the tax year were less than $1,000,000.

3. Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return.

4. The partnership is not filing and is not required to file Schedule M-3.

For more on line 6, see “Schedule L (Balance Sheets Per Books)” on page 31.

Tax Matters 
Partner

The designated Tax Matters Partner (TMP) is the partner who is available to discuss 
tax information with the IRS. TMP information is printed at the bottom of page 3 of 

NOTE
Which screens are required depends on the percentage owned. See 
Form 1065 instructions for calculating the maximum percentage 
owned.
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Form 1065. In Drake, the default Tax Matters Partner is partner #1 (the first partner 
entered on the K1 screen).

To designate a different partner, go to screen B and complete the Partner # field in the 
Tax Matters Partner section at the bottom of the screen. Note that most fields in this 
section are overrides; there is no need to enter additional information unless the part-
ner’s information differs from what is provided on that partner’s K1 screen.

If you don’t know the partner number, click K1 under the General tab of the Data 
Entry Menu. Either an Existing Forms List or a Grid Entry list (depending on your 
Setup Options) displays all partners with their respective numbers (Figure 4).

Figure 4: Schedule K-1, Partner Numbers

State-specific Information

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 to enter company information as it should appear on the state return. (Access 
screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 (accessible from the States tab) for the alternative data for 
registered office, principal place of business, “Books in care of,” and general contact 
information for the partnership’s contact person.

Other States Data for other states must be entered in state data entry. To access state data entry, 
select the States tab from the Data Entry Menu and select the desired states for state-
specific screens (or type the two-letter state code in the selector field and press 
ENTER).

NOTE The company information fields on screen 2 apply to the resident state 
only.
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Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (accessible from the States tab or by entering APPT in the selector field and 
pressing ENTER). This screen (Figure 5) provides one central location for entering all 
state apportionment information instead of having to open each needed state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (SA-SUM~) that can be used for verifying input, and a 
reconciliation worksheet (SA-REC) that ties the total of the state amounts to the fed-
eral return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake15 
but will be used to override data entered on the APPT screen.

Figure 5: APPT (Multi-State Apportionment) screen

NOTE
Mark the Zero Apportionment check box (Figure 5) to add a state but 
not include any apportionment data. This will include the state on the 
apportionment summary worksheet (SAC-SUM~), available through 
View mode.
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APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property information tabs for each state 
selected (Figure 5 on page 18). These screens and their uses are listed in Table 1.

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the partnership has a mailing address in one state but does busi-
ness in another, use the Resident state drop list to select the state in which the partner-
ship does business.

Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the Drake Software User’s 
Manual: Tax Year 2015:

– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 
“Installation & Setup.”

– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

Entity Name Control Override — Use this field only if your client has obtained a 
Name Control from the IRS.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake15 became the Beginning amount for property on the 
APPT screen when the client’s return is updated in Drake16.
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Schedule K (Partners’ Distributive Share Items)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items. 

Screens K and KFT

To promote greater accuracy in allocating Schedule K data to the individual partner’s 
Schedules K-1, and to improve the detailed statements provided to partners on their 
K-1s, Drake has made several enhancements to the Partnership package for 2015.

Screen K Among the biggest changes made was streamlining and consolidating data entry for 
Schedule K line items with a redesigned screen K. Screen K is now a “tabbed” screen, 
with separate tabs for data entry of Income, Deductions, Credits, AMT and Basis, 
and Other Information (circled in Figure 6).

Figure 6: Screen K is now tabbed (circled at the top of the screen)

Each of the tabs includes more “Other” items, such as “Other” income, “Other” 
deductions, “Other” credits, allowing a more detailed supplemental K-1 statement 
than ever before. (Figure 7 on page 21).

NOTES
Note the screen K fields are primarily adjustment fields. Press F1 in a 
field to see what amounts are adjusted from elsewhere in the program.

The K screens should not be confused with the K1, K1G, or other 
related screens.
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Figure 7: More detailed statements with Schedule K “Other” items

Special 
Allocations

It is easier now to override the calculated amounts of Schedule K items that are allo-
cated to partners on Schedule K-1.

The K-1 override fields that used to be on the K1 screens and were used to allocate 
amounts to partners have been removed. On the new Special Allocation screen 
(Figure 8 on page 22), reached by clicking an SA link on screen K, you can override 
the allocation any of the items on screen K for any or all of the listed partners.

For example, in Figure 8 on page 22, the calculated allocation to the partners of Ordi-
nary Business Income (item #1) of $121,221, is being overridden in Dollar 
Amounts (#2). As the allocations are entered in the Dollar Amount column, the pro-
gram shows the percentage of the total that equals the dollar amount allocated (#3). 
The program also keeps a running total of the allocated amounts and the amounts yet 
to be allocated (#4). To change from allocation by dollar amount to allocation by per-
centages, select Percentage (#5).
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Figure 8: New Special Allocations (SA) screen

Partners’ 
Capital 

Analysis

There are also links to the SA screen on screen M2. Use the SA screen in this instance 
to reconcile Schedule M-2, Analysis of Partners’ Capital, to the “Partner’s capital 
account analysis” in section L of Schedule K-1.

Property 
Distributions

Links to screen SA are available on screen 8825 and RENT to allow allocation of 
property.

3468 
Amounts

The Special Partner Allocations for 3468 Amounts link at the top-right corner of 
screen 3468 opens screen Schedule K Line 20C for Form 3468, allowing you to allo-
cate Form 3468 amounts to the partners.

NOTES

When the return is calculated, any amounts remaining unallocated will 
be allocated to the partners based on pro rata calculations of partners’ 
percentage as entered on screen K1. Enter “0” for any partner to 
remove the partner from the pro rata distribution calculation.

In the prior-year Drake programs, if an override was entered on the K1 
screens or using the old SA screen, the Section L, “Partner’s capital 
account analysis,” of the partner’s Schedules K-1 was not recalculated 
using the overridden totals. An entry was required in the “Other adjust-
ments” field of the Section L to reconcile the ending capital.

Now, Section L of the Schedules K-1 will be recalculated based on the 
overrides entered on the new SA screen.

NOTES SA screens should not be used for entering amounts on Schedule K.

SA screens cannot be used for any Schedule K line with a zero balance.
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Multiple Foreign Transactions

Screen Code: KFT Information on foreign transactions is now entered on a separate KFT screen, accessi-
ble from the General tab of the Data Entry Menu or from a link on the Credits tab 
of screen K. Through the KFT screen, you can now report multiple foreign transac-
tions. (Press PAGE DOWN for a new KFT screen.)

In addition, Drake now generates a “Foreign Transaction Statement,” shown as 
“WK_FTRP” in View mode (see Figure 9), that lists all of the partnership’s foreign 
transactions. A separate “K-1 Foreign Transaction Statement” (K1_FTRP) is gener-
ated, reporting these foreign transactions for the individual partner.

Figure 9: New Foreign Transaction statements for 1065 and 1120S

Business Activities Statement

A Business Activities Statement (screen BAS) allow you to break down a partner-
ship’s Schedule K items by business activity. The amounts and totals from the BAS 
screen do not flow anywhere in the respective business returns but do provide state-
ments you can use as a reference when transferring these amounts into the partner’s 
1040 return. A K-1 statement by business activity is also provided (Figure 10).

Figure 10: Business Activities Statement in the 1065 package   

The statement is listed in View mode as WK_BAS. The worksheets for the individual 
partner’s Schedules K-1 are listed as K1_BAS.
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Schedule K-1 for 1065 (Partner Information)

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

In the Type of Partner section, line G, select the box to describe the partner as either 
a General or LLC member-manager or a Limited or other LLC member (default 
is General). On line H, select either Domestic partner or Foreign partner (default is 
Domestic).

From the line I1 drop list (Figure 11), choose the type of partner (not the type of part-
nership). If this box is left blank, the program uses the default selection of Individual.

If the partner is a retirement plan (IRS, SEP, Keogh, etc.) mark the I2 check box.

Figure 11: K-1 Partner Type

Rounding Partner

Mark the check box on screen K1 (Figure 12) to select which should be the “round-
ing” partner. That partner will be listed last on the list of partners and will be the one 
who receives any balancing amount on Schedule K-1 when the return is calculated.

Figure 12: Rounding Partner check box

If you do not make a selection, the software designates as the rounding partner the first 
partner you entered. If you select more than one rounding partner, the program gener-
ates a Return Note telling you that you’ve chosen more than one rounding partner, and 
also tells you which partners will be used as the rounding partner and which won’t.
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Grid Data Entry

If you have your program set up to take advantage of grid data entry, you can easily 
enter amounts in many of the most-often used lines of a Schedule K-1. This method is 
particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake Home window.

2. From the menu bar, select Setup > Options open the Data Entry tab.

3. At the bottom of the left-hand column, select Use grid data entry format on 
available screens. Click OK.

Now, open a return, and from the K-1 Information section of the General tab, click 
K1 to open the data-entry grid. To make entries in the grid:

1. Select a partner and click in one of the fields where you wish to enter data.

2. Type in information for that partner for that column.

3. Scroll across to see more columns and make any entries needed.

4. Press the DOWN ARROW to make entries for other partners.

5. To open a partner’s K1 screen and make any other entries, click Item Detail.

6. To return to the grid, close the partner’s K1 screen.

You can arrange the grid by ID number, by partner’s name, or by the amounts in the 
columns of the grid by clicking the column headers. 

IRS K-1 Codes

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer inter-
pret the various codes used on Schedule K-1. To have this sheet printed with all K-1 
schedules, from the Home window of Drake, go to Setup > Options > Form & 
Schedule Options tab and mark the Print Page 2 of Schedule K-1 check box. The 
codes can also be printed on a return-by-return basis by marking the applicable box on 
the PRNT screen. The code sheet is also available from Tools > Blank Forms.

The Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code, or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached, or that the state-
ment is required (as in the case of “other” amounts).

NOTE
Code sheets are not displayed in View mode. If the 1065 K-1 is 
selected for printing, it is printed first, followed by the statements per-
taining to that 1065 K-1. These are followed by the code sheets.
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Returns with Numerous Partners

For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1s while working on Form 1065. This option, which eases 
the process of reconciling the 1065, is available by going to the PRNT screen and 
marking the applicable box under K-1 Items to Suppress.

Partner Overrides

To override calculated amounts for the partners, you can either make changes on each 
K1 screen or go to the SA screen for partner special allocations and make all changes 
there. For more information, see “Special Allocations” on page 21.

Foreign Addresses

If the partner has a foreign address, enter the Province/ State, Country, and Postal 
Code information in the Foreign ONLY address line of the Partner Name and 
Address Information section (along with the street address and city in the Address 
and City fields in section F.) Do not enter anything in the State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields.

Ownership Changes

All ownership change information is entered on the OWN screen, which is available 
from the General tab of the Data Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the 
partnership was exchanged by two or more partners. If profit, loss, and capital are 
all involved in a transaction, put the date in the Profit/Loss/Capital field only. 
The Loss and Capital fields are override fields, provided in case the loss or capi-
tal dates are different.

• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers entered on each K1 
screen).

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. (See field-level help for more infor-
mation.)

• To enter additional ownership changes, press PAGE DOWN.

NOTE After completing the K-1 entries for all partners, be sure to reactivate 
the calculation and printing of the K-1 from the PRNT screen.

NOTE
The Foreign ONLY fields are locked when a return is opened. Click in 
one of the fields to unlock them throughout the return. To relock the 
unused Foreign ONLY fields, close and then reopen the return.

NOTE See FAQ item “P” in the program for more information on entering 
ownership-change information.
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Printed Data A Summary of Change in Ownership worksheet (WK_POWN) is generated when the 
return is viewed. The WK_POWN is a list all partners and the ownership percentages 
and changes.

K-1 Export

Take the following steps to export a Schedule K-1 to a 1040 return.

1. Ensure that K-1 data is entered in the 1065 and that the 1040 return has been cre-
ated. (The K1P screen in the 1040 does not have to be created beforehand.)

2. In the 1065 return, go to View mode.

3. Click K1 Export in the View mode toolbar. A list of SSNs that cannot be 
exported appears, if applicable. (The reason the K-1 are ineligible for export 
appears in the Reason column.) Click Next.

4. The Export K1s dialog box (Figure 13) lists all client SSNs that can be exported. 
(To prevent an item in this list from being exported, remove the check mark to the 
left of it.)

Figure 13: SSNs ready to be exported

5. Click Export. The K-1 data will now appear on the partner’s 1040 tax return.

Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the 
Supplemental Information block of screen K1G. Select Global Supplemental 
Statement Information from the Select Type drop list, then type in the information 
in the large text box below. The information appears in all partners’ Schedule K-1 
Supplemental Information statements.

To add supplemental information to an individual K-1 statement, open a partner’s K1 
screen and click the Supplemental Info link at the top of the screen. In the Supple-

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.
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mental Information pane (Figure 14), enter information pertinent to the partner. The 
information appears in only that partner’s Schedule K-1 Supplemental Information 
statement.

Figure 14: In this example, the information entered on the K1S screen appears on only
partner 400001113’s Schedule K-1 Supplemental Information statement. 

Item M Question

If the answer to Schedule K-1, item M (“Did the partner contribute property with a 
built-in gain or loss?”), is “Yes” for all partners:

1. On the PRNT screen, select Yes in the Item M on Schedule K-1 section.

2. On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, 
and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.

Partner’s Adjusted Basis Worksheet

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.
28 Tax Year 2015



Drake Software Manual Supplement: 1065 Schedule K-1 for 1065 (Partner Information)
The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner. (Access the K1 screen from the Data Entry Menu.)

Increases 
and 

Decreases 
to Basis

Increases to basis can include cash contributed, taxable income of partnership (includ-
ing capital gains), tax-exempt income of partnership, and partner’s adjusted basis of 
property transferred to a partnership.

Decreases to basis can include distributions of cash or property to partners, separately 
stated losses and deductions, nondeductible business expenses, and credit adjust-
ments.

Annual 
Update of 

Partner 
Information

When the program is updated to the next tax year, the end-of-year basis and liability 
amounts are automatically updated to the beginning of the year. Any loss or deduction 
carryover is updated to the beginning of the year and its character (ordinary loss, sec-
tion 179 expense, charitable contributions, etc.) maintained.

Special 
Allocations

Use the new SA screen to allocate liability, capital, and K-1 Part III (Income, Deduc-
tions, Credits, and Other Items) amounts to individual partners without having to enter 
the information into each K-1 separately. Amounts can be entered as dollar amounts or 
percentages. Calculations from the SA screen flow to the appropriate fields of each 
individual K-1.

For information on the new SA screen, see “Special Allocations” on page 21.

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Indicate an amount of section 754 depreciation using either (but not both) of the 
following methods:

• On screen 4562, select 754 from the For drop list.

• On screen K (Deductions tab), line 13d, item W, “Section 754 depreciation” 
field, enter the amount of section 754 depreciation or amortization to be 
reported to the partners.

2. Allocate the amounts using the SA screen. (See “Special Allocations” on page 21 
for details on using the SA screen.)

Domestic Production Activities Deduction

A partnership does not take the deduction for Form 8903, Domestic Production Activ-
ities Deduction. Instead, the amounts pass through to the partners to report on their 
individual returns. The partners use the information to calculate their eligibility for the 
deduction. (For more information, see the IRS Form 8903 instructions.)

NOTE The Basis Worksheet is printed only when the option is selected on the 
PRNT screen.

NOTE If a K1 screen is marked as final, none of the related screens for that 
partner is updated for the next year.
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If Print K1_8903 worksheet for each partner is not selected on screen 8903, the 
amounts flow to line 12 of Schedule K-1 (codes Q and R). If this box is selected, the 
information flows to the K-1_8903, which is referenced on a statement. Code P is 
printed on line 12 of Schedule K-1 to indicate domestic production activities informa-
tion.

K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from 
the Home window of Drake, go to Setup > Options > Optional Documents tab and 
mark the box labeled Include K-1 letter with returns. Click OK, then open a return.

The signature on the return can be produced in one of three ways:

• By completing the Tax Matters Partner fields at the bottom of on screen B 
(Schedule B)

• By completing the partner information on the PIN screen (an entry here overrides 
the Tax Matters Partner information on screen B)

• By going to the K1L screen and entering the name and title of person signing the 
letter (an entry here overrides both screen B and the PIN screen)

NOTES

Line 11 (“Income limitation”) of the Form 8903 is not applicable for 
the partnership because the income limitation is calculated at the 
partner level.

“Form W-2 wages” (on the 8903 screen) refers to the partnership’s 
W-2 wages paid that are applicable to the Domestic Production 
Activities Deduction.

TIP

To prevent the partnership’s name and address from being generated 
in the header of the letter, go to the K1L screen (also called the LTR 
screen, both accessible from the Miscellaneous tab) and mark the Do 
not print entity information... box. (This assumes you first went to 
Setup > Communications Editor > Setup > Page Layout and 
selected the Use letterhead on letters box that would cause the entity 
info to appear as a header; otherwise, no header would be printed.)

NOTE If nothing is entered in any of the fields referenced above, the program 
will use the name of the partner on the first K-1 for the signature.
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Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Communications Editor. The Client 
Communications Editor is displayed.

2. Select Open > Partnership > Partnership K-1 Cover to view the template of the 
partnership K-1 letter.

3. Make any desired changes to the template.

4. Click Save.

Schedule L (Balance Sheets Per Books)

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 
to facilitate reconciliation of the balance sheet (item #1 in Figure 15).

Figure 15: Beginning- and End-of-Year totals displayed on L screen (#1);
force printing end-of-year totals (#2)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen) also 
appear in the BOY Totals and EOY Totals columns of the L screen.

TIP
Review the following sections of the Drake Software User’s Manual: 
Tax Year 2015 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup

- The “Letter Keywords” section of Appendix B, Keywords

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, from the Client 
Communications Editor toolbar, select Open > Partnership > Partner-
ship K1 Amended Letter and follow steps 3 and 4 of the previous pro-
cedure.
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If you make any changes to the data, recalculate the return (press CTRL+C) for those 
changes to be displayed on the screen.

Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000

• The partnership’s total assets at the end of the tax year were less than $1 million

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return

• The partnership is not filing, and is not required to file, Schedule M-3

If the partnership meets all four of these conditions, go to screen B and select Yes for 
line 6. Because Schedules L, M-1, M-2, and section L of Schedule K-1 are not 
required, they will not be generated with the return. (To force these items to be 
printed, go to the PRNT screen and, in the Items to Print section, select Force 
Schedules L, M-1, M-2, & K-1 Section L.)

If any of the four conditions are not met, select No for line 6. Schedules L, M-1, M-2, 
and Item L of Schedule K-1 are required and will be printed with the return.

Flow of Information

Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to the generated Schedule L. Depreciable asset information, intangible 
assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, bad debts, U.S. government securities, tax exempt securities, 
loans to partners, mortgage/real estate loans, depletable assets, and accumulated 
depletion. Other Schedule L data not entered on screen L would come from the part-
nerships’ income statement, balance sheet, and equity and capital accounts.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, indicating that this as a final-year return for 
a partnership or corporation, Drake “zeros out” the EOY Totals column of Schedule 
L. Mark the check box on screen L (see item #2 in Figure 15 on page 31) to display 
those totals in the EOY Totals column.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

TIP To speed up calculation of returns that contain multiple states, open 
screen 1 and select 0 from the Resident state drop list.
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To create a statement for a line, select the line from the drop list (see Figure 16) and 
enter descriptions and their corresponding amounts. Once the information is entered, 
or if additional descriptions are required for the line, press PAGE DOWN to access a 
new screen.

Statements The total amounts entered on the SCH2 screen do not appear on the L screen in the 
program. They are, however, printed on the return where applicable, with references 
to the corresponding statements.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 16).

Figure 16: Data entered as “Other Current Assets” from the drop list on screen SCH2 will be 
attached as an e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as they cannot be imported into the data 
entry. SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects the amounts imported from the trial 
balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 58.

NOTES

All line selections are carried to the next-year program when the 
returns are updated. Screen descriptions are updated, with the 
year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 
Screen hyperlinks on lines 6, 8, 13, 17, or 20 (or click inside a field 
and press CTRL+2).
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Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Schedule M-2 (Analysis of Partners’ Capital Accounts)

Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. The amounts on Schedule M-2 should equal the total amounts 
reported in item L of all the partners’ Schedule K-1s.

Drake carries amounts entered in item L (Analysis of Capital Account) on the part-
ners’ K1 screen to the Form 1065, Schedule M-2, line 1, “Balance at beginning of 
year.”

Schedules M-1, M-3 (Reconciliation of Income)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total 
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable, as 
described in Table 2:

Table 2: Examples of Book-to-Tax Difference for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets
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 New “Other” 
Adjustments

In the past, M-1 adjustments entered in the “Other” fields of screen M1 on lines 2, 4, 
6, and 7 did not adjust Section L, “Partner's capital account analysis,” of the partners’ 
Schedule K-1. The preparer had to make those adjustments manually in the Analysis 
of Capital Account section of screen K1 for each partner.

New for 2015: A new screen, the “Other” M1 Adjustments screen, specifically 
designed to make this Section L adjustment on Schedule K-1, has been added to the 
program. To open this new “Other” M1 Adjustments screen, from screen M1, click 
a blue Other hyperlink on lines 2, 4, 6 or 7 (circled in Figure 17).

Figure 17: New Other screen links from screen M1

On the “Other” M1 Adjustments screen, enter a Description and an Amount and 
close the screen. When you calculate the return, the amount entered on the “Other” 
M1 Adjustments screen has adjusted Section L of the Schedules K-1.

Return to screen M1 and you will see a gray “X” in a box beside the blue Other link 
(Figure 18), signifying that there is data entered on the new screen.

Figure 18: “X” indicates data entered on “Other” M1 Adjustments screen

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment

Table 2: Examples of Book-to-Tax Difference for Schedule M-1

Difference Description Examples
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Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

1. The amount reported on the Schedule L “Beginning of Year” accumulated depre-
ciation (line 9b, column a) (line 10b is “accumulated depletion”), is subtracted 
from the “End of Year” accumulated depreciation (line 9b, column c). This is the 
“book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the return, 
including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 4a

– Schedule M-3, Part III, line 25, as a negative amount

– Form 8916-A, line 2(L), as a negative amount for assets selected on the 
4562 detail screen for COGS

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 7a

– Schedule M-3, Part III, line 25, as a positive amount

– Form 8916-A, line 2(L), as a positive amount for assets selected on the 
4562 detail screen for COGS

Schedule M-3

The Schedule M-3 section of the Data Entry Menu includes direct access to the var-
ious M3 screens (Figure 19 on page 37).

NOTES

If you enter an amount on lines 2, 4, 6, or 7, and enter that amount 
again on the “Other” M1 Adjustment screen, the amounts will be 
added and the total will flow to Schedule M-1. (Only the amount entered 
on the “Other” M1 Adjustment screen will affect Section L of Sched-
ule K-1, however.)

To allocate these adjusted amount to the partners, click the SA link on 
the right side of the “Other” M1 Adjustment field. For more on using 
the Special Allocation (SA) screens, see “Special Allocations” on 
page 21.
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Figure 19: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 million (or that its gross receipts equal or 
exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

Force-Printing Schedule M-3

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the 
year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the 
total assets equal or exceed $50 million. If the corporation’s assets do not equal or 
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corpora-
tion’s assets do not equal or exceed $50 million and you wish to file the complete 
M-3, go to screen M3 and make a selection from the Force print schedule M-3 drop 
list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1, M-3 (Reconciliation of Income)” on page 34 for more details on 
these schedules.

The SCH3 
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the 
actual M3 screen in Drake. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program. They are, however, printed on the 
return as applicable, with references to the corresponding statements.

NOTES

The program calculates total assets based on IRS requirements. 
For more information, see the Adjusted Total Assets Worksheet 
produced with the return.

Some calculated amounts flow automatically to M-3; some data 
must be manually entered on the M3 screen. Review all amounts 
on the M-3.
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To create a statement for a line, select the desired line from the M-3 line identifier 
drop list on screen SCH3, then enter descriptions and their corresponding amounts. 
Once the information is entered, or if additional descriptions are required for the line, 
press PAGE DOWN to access a new screen (make the same selection from the Select 
line number drop list.)

As with the SCH2 screen, the type of statement produced by the program depends on 
the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 
Screen” on page 32 for more information on how to use the SCH3 screen.

Rental Activities
Screen code: 8825 Income and expenses for rental real estate properties appear on Form 8825, Rental 

Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake, use the 8825 screen, available from the Other Forms tab of the Data 
Entry Menu.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake program, and then the net 
results should be entered on screen 8825. The amount entered on line 14 is added to 
the depreciation calculated from the 4562 screens.

Carrying 
Information 

to Form 8825

To indicate that the information should be carried to Form 8825, select 8825 from the 
For drop list on screen 4562 (Figure 20 on page 39). If there are multiple 8825 
screens, use the Multi-form code box. For information on using the Multi-form code 
box, see the Drake Software User’s Manual: Tax Year 2015.

NOTE All line selections are carried to the next-year program when the 
returns are updated. 

NOTE Special steps are required if using the trial balance worksheet for mul-
tiple rentals. See “Rental Expenses” on page 59 for more information.

NOTE
For assets placed in service during the year, Form 4562 is required.

New for 2015: Drake produces one Form 4562 for each property on 
Schedule E and Form 8825 instead of one 4562 per Schedule E or 
8825.
38 Tax Year 2015



Drake Software Manual Supplement: 1065 Rental Activities
Figure 20: In this example, the program carries the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct 
Form 8825, based on the form and multi-form code selections at the top of the 4562 
detail screens.

Line 15, Other Expenses (list)

For rental properties with an “other” expense (line 15), enter the amount of guaranteed 
payments, health insurance payments, and meals and entertainment in the appropriate 
fields (see Figure 21). For rental properties with expenses not listed, enter those 
amounts in the Additional other expenses field. (An entry in this field opens a Detail 
Worksheet. Enter a description in the Description field and an amount in the 
Amount field.) The shaded field indicates a worksheet was entered.

Figure 21: Screen 8825, fields for line 15, “Other” expenses

Totals from the worksheet flow to Form 8825, and a statement from each property is 
printed with the return and is transmitted to the IRS when the return in transmitted.

Enter rental income the partnership receives on a Schedule K-1 on the K1P screen. 
This amount flows to Form 8825, lines 20a and 20b. No entry is required on the 8825 
screen.

IMPORTANT

When selecting a multi-form code, note that the code 
should refer to an 8825 screen—not the 8825 form. For 
example, data from the third 8825 screen will be gener-
ated on the first Form 8825. To associate an asset with 
that information, you would enter a “3” for the screen (not 
a “1” for the form) in the Multi-form code box. For more 
information on Form 8825, see “Viewing Rental Activity 
Information” on page 40.

NOTE
Entries in the “Guaranteed payments” field and “Health Insurance 
payments” field on line 15 do not flow to line 10 of Form 1065 but do 
flow to Form 8825 and adjust the amounts on lines 2 and 4 of Sched-
ule K.
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Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

• 8825 Forms — Form 8825 can contain information for up to eight rental activi-
ties. If more than four rental activities are entered, a second page of Form 8825 is 
generated. If more than eight rental activities are entered, a second Form 8825 is 
created.

Figure 22: Multiple 8825 pages are created if more than eight rental activities

• 8825 Statements – Statements are titled STM 8X, where X equals A to H for the 
first Form 8825. (For example, the statements for the first and second 8825 
screens would be labeled STM 8A and STM 8B, respectively.) (See Figure 23.)

Figure 23: 8825 statements and attachments

Self-Employment Income

If Mark this box to include in self-employment income is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a of Schedule K and flow to each K-1. Self-employment calculations are shown on 
the WK_SE worksheet generated with the return.
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Royalties Worksheet

New for 2015: A new worksheet for reporting royalty expenses and income was added 
to the Partnership package.

Instead of generating Form 8825, Rental Real Estate Income and Expenses, when roy-
alty income and expenses are listed on screen 8825 (and Royalties is selected from the 
Type of property drop list), Drake now generates the Royalty Worksheet
 (“WK_PROY” in View mode).

When a 1065 return is viewed, instead of the royalties income and expenses flowing to 
box 2, “Net rental real estate income,” of Schedule K-1, gross royalties flow to Sched-
ule K, line 7, “Royalties,” and expenses to Schedule K, line 13d, “Other deductions.” 
These amounts are also on the Royalty Worksheet.

Form 8825 isn’t generated unless it is otherwise needed.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake 2015 carries 
the required adjustments to the appropriate line of the return and to the M-1.

Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Biofuel Producer Credit

• Form 8864, Biodiesel Fuels Credit

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8845, Indian Employment Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8844, Empowerment Zone Employment Credit

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

NOTE No adjustment is carried to the M-3 automatically for 2015.
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Elections

The ability to make certain tax elections is included in the Partnership Package. Elec-
tions are made and described on the ELEC screen (Figure 24).

Figure 24: Election fields of ELEC screen

Making an Election in Drake

Screen code: 
ELEC

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list.

3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 25 on page 43) 
shows that the field is required only for election options 08, 11, 13, 15, and 21, 
and it explains what, specifically, should be entered for each of these elections.
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Figure 25: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as STM 
EL01.

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Safe Harbor Elections 

A check box on screen 4562 applies a small taxpayer Safe Harbor election to a build-
ing listed in the Description field. An election statement will be produced and the 
building description as entered in the Description field will be included in the election 
statement (see Figure 26 on page 44).

This Sec. 1.263(a) - 3(n) Election can also be made from the ELEC screen, as can a 
Sec. 1.263(a) - 1(f) de minimis safe harbor election.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

NOTE
If the election option you selected is not listed in the help text for a 
field, then that field should be left blank. For example, if you chose 
election 01 (General Election Statement), you would not need to 
enter anything into the Date or year-ending field (help text in 
Figure 25).

NOTE This Safe Harbor election covers buildings only.
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Election statements are generated with the return (Figure 26).

Figure 26: Election statement generated with ELEC screen selection

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on the fly” changes override options that are global 
in Setup. 

1065 Items The following Form 1065 items can be forced or suppressed from the PRNT screen.

• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section L are not printed unless required. To have these schedules printed 
with the return, select this box.

• Print Form 8893, Election of Partnership Level Tax Treatment — Select this 
box to generate Form 8893 with the return. (There is no equivalent 8893 screen, 
but the form is produced. All information for the form is available from other data 
entry screens.)

• Print Form 4562 — Form 4562, Depreciation and Amortization is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, 
and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule if the option is not already selected in Setup > Options > 
Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inac-
tive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, 
enter the preparer’s PIN here.
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• Items to Suppress — Select the boxes corresponding to any worksheets, forms, 
or functions you do not want printed with the return:

– ATT_PTL (Taxes and Licenses Attachment) or the ATT_PSW reference on 
page 1

– Estimated Tax Payment Summary

– Printing of WK_M2, Partners’ Capital Reconciliation Worksheet

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to print:

– The partner’s adjusted basis worksheet

– Page 2 of Schedule K-1 (codes)

• Select to Suppress:

– Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS

– Schedule K/K-1 Comparison Worksheet or the Capital Account Reconcilia-
tion

– K1_179 for each partner

– Marking of “Amended K-1” box on printed Schedule K-1

• Item L on Schedule K-1 (Partner’s capital account analysis) — Select the box 
(item #1 in Figure 27) to indicate the calculation method used for the partners’ 
capital account. (If Other, indicate the method in the text box; this item is 
required.)

Figure 27: Items L and M of PRNT screen

• Item M on Schedule K-1 — Select a box (item #2 in Figure 27) to answer item 
M of Schedule K-1 for all partners. To answer it for each individual partner, go to 
the partners’ K1 screens. See “Item M Question” on page 28 for more informa-
tion.

See field help (F1) for more information on the options available.

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, 
state, city, and K-1s to partners) can be either forced or suppressed from the PRNT 
screen to override the global setting in Setup.

In addition, you can select Turn off autobalance to disable the autobalance feature 
(see “Autobalance” on page 34) and select Prepare a Form 7004 extension if send-
ing an extension application. (See “Filing an Extension” on page 13.)
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The following program defaults can also be overridden from the PRNT screen:

• Date to print on return

• Due date to print on letter and filing instructions (see note below)

• Amount on Form 1065, page 1, item F (“Total assets”)

• IRS Service Center

Much of the information contained in the worksheets is also available from the field-
level helps within the program. To access a field-level help, click inside a field and 
press F1, or right-click in a field and select Help > Help for this Field.

Electronic Filing

Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-file is 
optional.

Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the excep-
tion of Bankruptcy return, which must be paper-filed. For detailed instructions on
e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 2015.

Additional Return Types

The following special types of business returns can be e-filed using Drake:

• Returns for entities using a 52-53–week year

• Short-year returns

• Inactive returns

For information on how to indicate a short-year return in Drake, see “Short-Year 
Returns” on page 4.

Electing a 
52-53–Week 
Year (Initial 

Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the Year screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in Figure 28 on page 47.

2. Mark the 52-53-week tax year box.

NOTE
A default due date for filing is printed on all letters and filing instruc-
tions generated with a return. You can override the default by enter-
ing an alternate due date in the Due date to print on letter and 
filing inst field.
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Figure 28: In this example, the fiscal year begins 12/30/15 and ends 12/2816
(the Wednesday closest to the end of December), giving the entity a 53-week year for 2015.

3. Click the Year link to open the Election Options screen (Figure 29).

Figure 29: Elections for 52-53–week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive 
Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab or the Miscellaneous 
tab of the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a and 1b). Zeros are dis-

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that 
accounting period every year. To change accounting periods, the 
entity must submit to the IRS Form 3115, Application for Change in 
Accounting Method.
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played where required by the IRS in order for amounts to be properly included in the 
e-file data.

Common Error Codes

If one or more of the following IRS error reject codes is generated when you e-file a 
1065 return, you must contact the IRS for further information.The e-file help desk 
number is (866) 255-0654.

• Reject Code R0000-922-01 — Filer’s EIN and name control in the return header 
must match data in the E-File Database, unless “Name Control” or “Name of 
address change” check box is checked, if applicable.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for the EIN.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with the 
return.

Screen code: PDF Attach PDF files to federal partnership (1065) returns for e-file. The PDF Attach-
ments screen is accessible from the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

NOTE All EF messages must be cleared in order to e-file an inactive return.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, go to 
www.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Using-the-
Correct-Name-Control-in-e-filing-Partnership-Tax-Returns
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1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake. From the Data Entry Menu, click PDF Attachments, 
accessible from the Electronic Filing section of the General tab (or type PDF in 
the selector field and press ENTER). (Figure 30)

Figure 30: Select PDF Attachments, or type PDF into the selector field and press ENTER

2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF Message regarding the attachment when the return is calculated.

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1065

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents in Drake” on page 49), there will be two 
PDF–related items in the View/Print window:

• An “MESSAGES” alert (item #1 in Figure 31)

• An Attach PDF button on the toolbar (item #2 in Figure 31)

Figure 31: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the MESSAGES file to view EF Messages, including information on how to 
attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. A red X 
means the document has not yet been attached; a green check mark indicates an 
attached document (Figure 32).

Figure 32: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).
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Repeat for all documents with a red X. When all documents have been attached to a 
completed return (and show a green check mark), recalculate the return. If all EF Mes-
sages have been resolved, the return is ready to be e-filed.

Importing Trial Balance Information

Drake trial balance import feature allows data to be imported into a 1065 return from a 
trial balance worksheet. The trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. Like several other functions of the tax software, this feature 
requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake 2015 or 
update an existing client file from the prior year.

Then take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” To do so, go to 
File > Options in Excel and select the Trust Center tab. Click Macro Settings 
and select Disable all macros with notification, then click OK.

• Disable Autobalance in Drake — (optional) When autobalance is disabled, the 
program is prevented from automatically adjusting the year-end retained earnings 
or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. To disable autobalance, go to the PRNT screen (available from the General 
tab or the Miscellaneous tab of the Data Entry Menu) and select Turn off auto-
balance (Figure 33 on page 52).

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).

NOTE

In Excel 2007, click the Office button in the upper left and then click the 
Excel Options button at the bottom of the window. In Excel 2010 and 
2013, click the File tab then select Options from the menu on the left. 
Next, select Trust Center from the list at left, then click the Trust Cen-
ter Settings button. Select Macro Settings from the list on the left, 
then choose Disable all macros with notification. Click OK and then 
OK.
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Figure 33: Disable autobalance in Other Return Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you will have to override the default in order to have the amounts shown 
on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the Force Schedules L, M-1, M-2, & K-1 Section L box 
(Figure 34).

Figure 34: Force Schedule L box for 1065 package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail work-
sheets (CTRL+W) that are not required. For example, the IRS does not require a 
detail worksheet for the Gross receipts field on the INC screen; if a return has a 
detail worksheet for that field, the trial balance will not be imported correctly into 
the return. Detail worksheets are indicated by red shading, as shown in Figure 35.

Figure 35: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 54 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.
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To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake15 pro-
gram. 

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 36 on page 54; see also Figure 39 on page 55).

NOTE
In Excel 2007 and 2010, you may see a Security Warning message 
with an Options button. Click Options to open the Security Options 
dialog box, then select Enable this content. Click OK. (In Excel 2013, 
click Enable Content.)

NOTE If saving a trial balance to a different location, make a note of where 
you store it. The program automatically looks in the default directory.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Form, Page, Schedule, and/or 
line

Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 57.
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Figure 36: Schedule M-1 amount (item #1); totals (#2); and indication of balance (#3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 37). If these cells do not work, you may need to enable 
them; see the Note in “Opening a Template” on page 52.

Figure 37: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 38 on page 55 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 57.
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Figure 38: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the PTR TB tab (labeled “1” in Figure 38) 
or click the Click to return to TB button above the worksheet tabs (labeled “2” in 
Figure 38). Note that a detail tab (the “Other Income” tab in Figure 38) might include 
one or more detail worksheets (labeled “3” in Figure 38). 

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 39).

Figure 39: Out-of-balance amount is highlighted if columns are out of balance.

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet or the trial bal-
ance will not be imported correctly.
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In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software (see Figure 39 on page 55).

Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In Excel 
2007 and 2010, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. Trial balance templates are saved in the “TB” folder of your Drake15 soft-
ware.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. If necessary, click the button to 
the right of 1. Import File Name to browse to the proper folder. By default, each 
trial balance file is an Excel (.xls) file showing the client name and ending in 
“TB” for trial balance, as shown in the example in Figure 40. (See “File Location” 
on page 53.)

Figure 40: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

NOTE The data cannot be imported if the worksheet is out of balance.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 57.

If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake and start at Step 3 of 
the following procedure.
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6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

By default, the program imports the following additional information when importing 
the trial balance data:

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake data entry. Other items should be entered into the work-
sheet for balance purposes but are not carried to data entry; these must be entered sep-
arately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items go directly to the location indicated in the program and on the 
return. For example, the amounts shown in Figure 41 go to Schedule L, line 1, column 
d in the program and are shown on page 5, line 1, column d of the 1065 return.

Figure 41: Indication of where an amount will go in Drake and on the return

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 describes the most 
common notes in this column.

Buildings and other depreciable assets Accumulated depreciation

Goodwill and other intangible assets Land

8825/Rent information Accumulated amortization

COGS depreciation

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in the 
“Reported on” column to the left of “Other Information.”
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All “does not import” notes are accompanied by further instructions in the “Reported 
on” column to the left of the “Other Information” column, as shown in Figure 42.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance. (Figure 42)

Figure 42: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in data entry:

Screen code: 
SCH2

1. Open the SCH2 screen for the return.

2. Select the line number from Select line number from drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN and repeat steps 
2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screens.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.

Table 5: “Other Information” Column Notes

Note Description
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For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable. Because the remaining depreciation can comprise any number of assets, 
the amount entered on the trial balance does not flow to the return. To ensure that each 
component of the total remaining depreciation is calculated into the return, each asset 
must be entered on the applicable depreciation screens in data entry (Figure 43).

Figure 43: Enter depreciable asset data on a 4562 detail screen,
or enter the total depreciation on the override screens

Rental 
Expenses

The following information applies only for partnerships with multiple rental proper-
ties.

The partnership trial balances include lines for rental income and expenses 
(Figure 44). Both rental expense items require a trial balance detail worksheet.

Figure 44: Rental expense rows on a trial balance worksheet

NOTE
Enter 8825 and RENT depreciation amounts in the detail worksheets 
for importing purposes, but be aware that the 8825 and RENT screens 
in the program will need to be edited if 4562 detail screens (see 
Figure 43) are used.

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 44 on page 59).

3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 
the calculated return to ensure that they match.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake customers can fill out and e-file Forms 3115 and related schedules and attach-
ments for corporation returns.

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appears to have been imported 
correctly, an M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.

NOTES
In some cases, Form 3115 must still be paper-filed.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for 
general automatic change procedures, and to Rev Proc. 2015-14 
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.
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Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the first Other Forms 
tab of the Data Entry Menu (Figure 45).

Figure 45: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six tabbed screens. As 
shown in Figure 46, you can access the various 3115 screens by clicking a tabbed link 
at the top of any of the 3115 screens.

Figure 46: Tab links on 3115 screen

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 46) 
that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 
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other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF messages (as applicable) when the return is calculated. All forms, schedules, EF 
messages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the EF_PDF~ worksheet to the list on the EF message 
page.

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.

TIP
Click Screen Help in the upper right corner of screen 3115 to access 
links to Revenue Procedures 2015-13, 2015-14, and 2015-20 through 
the IRS website.

NOTE
All EF messages must be eliminated before the return is eligible for 
e-file. EF messages for Form 3115 attachments are eliminated when all 
required statements have been attached to the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a partnership tax return from a 
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See the next page for a flow chart describing the use of the trial balance import.
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Index 

Numerics
52-53-week year returns 46

A
accounting method

changing 47, 60
entering on 1065 5

accrual (accounting method) 5
address

change of 5
entering on Form 1065 4
foreign 26
on K-1 letter heading 30
out-of-state 19

adjusted basis worksheet 27, 28–29, 45
adjustments

depreciation 36
to income and expenses 41

allocations
section 754 29
special (screen SA) 26, 29

amending
a 1065 return 5, 15
and TEFRA audit rules 15
K-1 letters 31

amortization 12, 13, 32
analysis

of capital accounts (Schedule M-2) 34
APPT screen, see Multi-State Apportionment
asterisks (on K-1 codes) 25
attachments

binary 48
to Form 3115 60

autobalance 34, 45

B
bad debts 8, 9
bankruptcy returns, e-filing not allowed for 46
basis 28–29

see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 34–36
business activity codes 5

C
calendar year returns 4, 13

cash (accounting method) 5, 9
change

of name or address 5
Change in Accounting Method 60–62
Client Communications Editor (for letters) 31
codes

business activity 5
error/reject 48
K-1 25, 45
miscellaneous (screen 1) 19
multi-form 38, 61

compensation of partners 8
contact information (for state returns) 17
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 30
coversheets 45
credits 7, 13, 41
Ctrl+W (detail) worksheets 6, 8, 52

D
data entry

for state information 17
importing trial balance into 51–60
state tabs in 17

dates
business start 5
tax year 4

decrease to basis 29
deductions 8–13, 29
depletion 12
depreciation

entering 11–12
for cost of goods sold (Schedule A) 6
of rentals 11, 38
on short-year returns 5
printing Form 4562 44
trial balance (business returns only) 58

detail (Ctrl+W) worksheets 6, 8, 52
domestic production activities deduction 29
due dates 13

E
EF_ACK page 2
e-filing 46

Form 8879-PE 14
PDF attachments 48
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Elections
Safe Harbor 43

electronic signatures (PIN) 14
employee benefit plans 13
envelope coversheets 45
error codes 48
expenses 8–13
exporting K-1 data 27
extensions 13, 45

F
farm profit or loss 7
filing instructions 45
final return 5
fiscal year returns 4
force print

end-of-year toitals 32
foreign

addresses for partners 26
ownership 16

foreign tax withheld 3
Form 3115 (Application for Change in Accounting Meth-

od) 47, 60–62
Form 4562 (Depreciation and Amortization) 38, 44
Form 4797 (Sales of Business Property) 7
Form 5884 (Work Opportunity Credit) 41
Form 6478 (Biofuel Producer Credit) 7, 41
Form 6765 (Credit for Increasing Research Activities) 13, 

41
Form 7004 (Application for Automatic Extension of Time 

to File) 13
Form 8082 (Notice of Inconsistent Treatment or Amended 

Return) 15
Form 8820 (Orphan Drug Credit) 13, 41
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 38–40
Form 8825 (Rental Real Estate) 40
Form 8844 (Empowerment Zone Employment Credit) 41
Form 8845 (Indian Employment Credit) 41
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 10, 41
Form 8864 (Biodiesel Fuels Credit) 7, 41
Form 8873 (Extraterritorial Income Exclusion) 13
Form 8879-PE (IRS e-file Signature Authorization for 

Form 1065) 14
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 41
Form 8893 (Election of Partnership Level Tax Treatment)

44
Form 8903 (Domestic Production Activities Deduction) 29
Form 8912 (Credit to Holders of Tax Bonds) 41
Form 8912 (Credit to Holders of Tax Credit Bonds) 41
Form 8916A (Supplemental Attachment to Schedule M-3)

37
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 41
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 13
Form T (Forest Activities Schedules) 12

G
gains and losses 7
grid data entry 25
gross receipts 6
guaranteed payments 8

H
header information 4
health insurance 13
health savings account (HSA) 9

I
importing trial balance 51–60
inactive returns 47
income 6–8
increase to basis 29
instructions for filing 45
insurance

and contributions to benefit plans 13
proceeds, income from 8

interest
expense 10
income 8
ownership of (Schedule B) 15–17

inventory (on Schedule A, Cost of Goods Sold) 6
IRAs 12
Item M (on Schedule K-1) 28

K
K-1, Schedule for 1065 24–28

L
letters (K-1) 30

M
M, item (on Schedule K-1) 28
M-3 32
maintenance costs 9
medical care for employees 13
Multi-State Apportionment 18
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N
name change 5
name control reject 48
net

farm profit or loss 7
gain or loss 7

next-year depreciation listing 44
number of partners 5

O
ordinary gains and losses 7
other

costs (Schedule A) 6
deductions 13
income (loss) 7

overrides
of calculations for partners 26
on screen 1 19

ownership
changes 26
of interest (Schedule B) 15

P
partners

compensation of 8
foreign addresses for 26
guaranteed payments to 8
health insurance 9
number of 5
returns with numerous 26
rounding 24
Schedule K-1 24
special allocations for 29
updating data annually 29

partnership, termination of 5
payments, guaranteed 8
PDF 50
PIN (electronic) signatures 14
printing

1065 returns 44
adjusted basis worksheets 45
cover letter for K-1 30
force 44
Form 8903 for each partner 30
K-1 items 26
suppressing/forcing documents 44

prior-year returns, updating 3

R
real estate 58
receipts 6

refunds, state 8
reject codes 48
rent paid on business property 10
rental activities 38–40
repair costs 9
resident state 17, 19
retirement plans 12
returns

52-53-week year 46
bankruptcy 46
extensions for 13
fiscal and calendar year 4
inactive 47
short-year 4
signing 14
updating prior-year 3

royalties worksheet 41

S
Safe Harbor Elections 43
scanning attachments for e-filing 48
Schedule A (Cost of Goods Sold) 6–7
Schedule B (Other Information) 15
Schedule K (Partners’ Distributive Share Items) 20
Schedule K-1

grid data entry 25
Partner Information 24–28
Supplemental information 27

Schedule L (Balance Sheet per Books) 31–34, 44
Schedule M-1

adjustments 33
Reconciliation of Books 34
Reconciliation of Books With Return 44

Schedule M-2 (Analysis of Capital Accounts) 34
Schedule M-3 (Net Income (Loss) Reconciliation) 36
section

179 12, 29
481 8
754 12, 29

self-employment income 40
SEP or SIMPLE plans 12
short-year return 3
short-year returns 4
signatures, electronic 14
special allocations 21
special allocations (screen SA) 26, 29
state

overriding information related to 19
resident 17
tabs in data entry 17
tax refunds 8

state-specific information 17
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T
tax

years (fiscal vs calendar) 4
Tax Equity and Fiscal Responsibility Act (TEFRA) 15
Tax Matters Partner 16
taxes and licenses 10
technical termination 5
termination of partnership 5
trial balance import

and depreciation 7
and SCH2 screens 33
instructions for using 51–60

U
updating

a prior-year return 3
partner data annually 29

W
wages 8

Y
Year screen 4
x Tax Year 2015
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